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Chapter 1 - Getting Started   

1.1 Installation Instructions 

Step 1: Turn on your PC and place the installation CD into the CD-ROM drive.  

Warning! DO NOT connect the Dino-LIte Digital Microscope USB cable to the PC before driver 
installation.  

Step 2: The installation program will run automatically once the installation CD is placed into the 
CD-ROM.  This screen will appear.  Press “Continue.” 

 

 

Step 3: The following screen will appear. Select “Driver Installation.” 
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Step 4: The Installation Wizard will come up. Click “Next” on the bottom of this screen. 

 

Step 5: The License Agreement will come up.  Please read the License Agreement carefully.  
To install the Dino-Lite Plus and Pro you must accept the agreement.  After reading the 
License Agreement, click “Yes” to accept.  

 

Step 6: When the “Choose Destination Location” screen comes up, select “Browse” to choose 
your own destination folder for program installation.  Click “Next” to continue.  
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Step 7: When the “Ready to Install the Program” page comes up, click “Install” to continue. 

 

Step 8: When the “Software Installation” warning message appears, click “Continue Anyway.”  

 

Step 9: This screen will appear to notify you that installation has been successfully completed.  
Click “Finish” to continue. 
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Step 10: You will be brought back to this screen. Choose “Exit,” and plug-in the Dino-Lite Digital 
Microscope USB cable. 

 

Step 11: Once you have connected the microscope to your computer via the USB connector, 
the “Found New Hardware Wizard” window will appear. Select “No, not this time” and click 
“Next” to continue. 

 

Step 12: When the “Found New Hardware Wizard” brings you to this page, we recommend that 
you select the option “Install the software automatically” and click “Next” to continue. 

 



DinoCapture User’s Manual 

Step 13: When the “Hardware Installation” warning message appears, click “Continue Anyway.” 

 

Step 14: When the “Found New Hardware Wizard” has completed the installation, click “Finish.” 
After  the window closes, check on your desktop for the Dino-Lite icon. If you cannot find it 
there, go to “Start” � “All Programs” � “Dino-Lite Digital Microscope.  

 

NOTE: Before you attempt to initialize the Dino-Lite Digital Microscope, make sure it is 
connected to the USB port of your computer. If you have more than one USB port, depending 
on your computer, it may prompt you to install the hardware again on different USB port. To 
avoid this, try connecting the microscope to the same USB port you originally installed it through.  
The screen below will appear is the Dino-Lite Digital Microscope is not yet installed completely 
when opening the DinoCapture. 

 

NOTE: We suggest you close DinoCapture before disconnecting the Dino-Lite Digital 
Microscope from your computer. 
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1.2 Important Note for Windows Vista Users  

When attempting to run the DinoCapture with Windows Vista for the first time after installation 
and update, please RIGHT CLICK the DinoCapture icon and select “Run as Administrator” from 
the pop-up menu.  Then confirm the operation by clicking “OK” on the Microsoft Vista pop-up 
screen.  

This is a one time process after which your computer will recognize that the Run DinoCapture is 
authorized by the administrator. After this additional one-time procedure, you will then be able to 
double click on the DinoCapture at any time for future use.  
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Chapter 2 - Using File Functions  

The file functions shall only be available after one or more picture or video in the scroll list have 
been selected. Most of the file functions can also be found in the pop-menu when right-clicking 
the desired images.  

2.1 Open 

The “Open” tab under the “File” tab will open an all ready existing image in a separate box.  

2.2 Save As 

The “Save As” option first allows you to choose the resolution quality you would like to save the 
image with. After you have chosen the desired resolution, you can save it in whatever location 
you choose in your computer, or save it in a different format.   

2.3 Copy 

The copy option will give you two options when it opens: Copy Image or Copy File.  If you 
choose to copy image, select “yes”. This will copy the image to and hold it on the clipboard until 
you “paste” it in the desired destination. If you select the “Copy File” option, the image file will be 
copied until you paste it unto your desktop or another desired destination.  

 

2.4 Share 

The Share function will copy the selected pictures to the Shared Documents > Shared Pictures 
> DinoShare, or copy the selected pictures to the Shared Documents > Shared Video > 
DinoShare so that the other computers on the same local network will be able to view the 
pictures or videos you share.  

When you click on the “Share” tab, Dino Lite will allow you to choose the resolution of the image 
you would like to use when you share the image.  The default is set to 640*480, but you may 
modify this by clicking on the bubble to the left of the desired resolution.  
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2.5 Mail 

The “Mail” option will allow you to email the image to a third person. As with the “Share” option, 
you will also be prompted to choose the image quality you desire. After you have chosen the 
image quality you desire, you will be prompted to name the file. Lastly if your computer is not set 
up to send mail automatically, the Internet Connection Wizard in your computer will guide you 
through the steps to set up the feature.  

 

2.6 Set Magnification  

Once you have captured the image, enter a magnification value as it appears on the 
microscope's dial. This will allow you to take and record measurements such as length, angle, 
and the circumference of a circle. These measurements can be placed, seen and recorded 
directly on the image being studied.  

 

 

NOTE: In order to take the measurements just mentioned, a magnification value for each image 
captured must be entered. See chapters six and seven of this manual for more information on 
setting magnification values.  
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2.7 Delete Select  

This option allows you to delete the image or video you have selected from either the “Picture” 
or “Video” tab.  

 

2.8 Delete All 

The “Delete All” option permits you to delete all of the images or videos shown on either the 
“Picture” or “Video” tab. Before deleting one or many images, you will see a prompt which will 
ask you to confirm that you want to delete either one image, a few selected images, or all 
images.  

2.9 Exit 

The “Exit” option will directly close Dino-Lite and exit you out of the program.
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Micro 

Touch 

Chapter 3 - Dino-Lite Settings  

Under the settings tab you will find the following options listed below: 

 

3.1 Microtouch 

Disable: Allows you to enable or disable the Microtouch feature.  

One Touch: Allows you to set the Microtouch feature so that it takes a picture of what you aim 
at with a single touch of your finger 

Double Touch: Allows you to set the Microtouch feature to take a picture by touching it twice in 
about one second on the designated area.  This feature is designed to avoid unwanted pictures 
being taken by an unintended touch.   

 

 

 

 

 

 

 

 

 

 

 



DinoCapture User’s Manual 

13 

 

 

3.2 Run DinoCapture with Microtouch 

The “Run DinoCapture with Microtouch” tab allows you quickly start the DinoCapture program 
simply by pressing the Microtouch. 

3.3 Audio Setting  

The audio setting allows you to save the audio portion of the video you capture. When you click 
on the “Audio Settings” tab, you will be given the option to select the sound format you would 
like to save the sound in. 

 

To save the sound in a specific format, go to the Attributes drop down menu and select the 
audio quality of your choice.  

 

If you desire you may save the sound settings with a specific name by clicking on “Save As.” 
Once you have given that setting a name, it will appear on the pull down menu under “Name” as 
shown bellow. 

3.4 Real -Time Image Setting 

The “Real-Time Image Setting” allows the user to regulate and modify the brightness, color, 
saturation, etc. of the image you are viewing in real-time.   
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3.5 Resolution 

By clicking on the Resolution tab, you will be given the option to choose the resolution quality 
you desire for your images.   

 

3.6 DinoCapture Auto Update 

DinoCapture Auto Update allows you to update your Dino-Lite Microscope whenever there is an 
improvement in the software.  When the DinoCapture Auto Update is enabled, the DinoCapture 
will automatically check if any updates are available on the Internet when the program starts. 

 

To check whether a new version of the Dino-Lite Digital Microscope is available, simply click on 
the DinoCapture Auto Update, or click on the DinoCapture Update under Help. A new window 
will open and inform you whether there are any updates or new versions of the software.  
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3.7 Sound Effect  

This will enable or disable the photographic camera shutter sound effect whenever you take a 
picture. 

 

3.8 Cross Line 

This function allows you to display a cross line on the preview screen which could be useful in 
some industrial applications.  

To use the Cross Line function, click on the Cross Line tab. A window will open up allowing you 
to set the X/Y coordinates of the object you desire to measure.  
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3.9 Annotations  

To show or hide an annotation made on an image, go to the “Annotation” tab and click on 
“Show.”  This will allow you to see input and any annotations you make on the dialog box that 
opens at the top of the captured image.  

If you desire the annotation to be imprinted on the image, select “Imprint” before saving or 
emailing it. 

3.10 Coordinates 

This option allows the user to “Show” and to “Set” the coordinates. 

As with the “Cross Line” function, the “Coordinate” function also allows you to set X/Y 
coordinates of the object being studied. 

To set the coordinates, click on :Coordinate” then click on “Set”.  This will bring you to a screen 
from which you can assign the X and Y coordinates their desired value. 
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3.11 Magnification  

Set Real Time Magnification  

If the Dino-Lite is used in a way that the magnification rate will not be changed and the focus 
dial will not be adjusted, this function could help you enter the given magnification rate to each 
picture taken after this function is enabled.  

When “Set Real Time Magnification” is selected, this function will open a text box on the top 
right of the DinoCapture screen where you can input the magnification rate.  

To determine the magnification value of the image, refer to the reading on the center of the 
focus dial indicated by a small node.  This constitutes the magnification value for the captured 
image. 

 

 

 

 

 

 

 

 

 

Set Magnification After Capture 

When activated, this option will bring up a box prompting you to enter the magnification every 
time after capturing each picture.  This option could help you do measurements after taking 
multiple pictures. 

Show  

When activated, the “Show” option will show the magnification rate on the images captured. 

Imprint  

The imprint option will allow you to imprint the notes keyed into the dialog box that opens at the 
top of  the screen.  
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3.12 Date & Time 

The date and time function allows you to show the date and time when you took each picture. 
To show the date and time on the images you take, go to the Settings tab, then DateTime tab 
and select Show.  

To show an imprint of the date and time on the pictures taken click on “Imprint.” A check mark 
will appear on the left of the imprint tab indicating that the function has been activated. 

 

 

 

 

 

 

 

 

 

3.13 Skin Setting 

This function allows you to choose the Color Scheme for the display window. You can choose 
between three colors: Metallic, light blue, and dark blue.  

To select the display setting of your choice, simply click on the color scheme you desire and it 
will automatically change to the selection of your choice. 
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Chapter 4 - Capturing Still Images 

4.1 Taking Pictures 

 

To take a picture of an image you can use any of the following methods:  

- Go to the Capture Tab and click on “Picture” 

- Click on the Camera icon 

 

- Left-click on the Real-time preview screen 

- Activate and use the Microtouch feature 

- Press F11 

Once you have taken a snapshot of the desired object, the picture will appear under the picture 
tab on the left of your screen. To open a picture double click on the selected image. 
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After you double click on the photo on the picture tab, the image will open on a separate window 
which  will show a toolbar with options. For a quick look at what each tab is, drag your mouse 
over each icon.  

 

For information on how to use measurement and calibration functions contained in the icons 
above go to chapters six and seven.  

NOTE: The following Dino-Lite Digitlal Microscope models contain the Measurment & 

Calibration Functions:   

AM413T Series, among which, but not limited to, are the AM413ZT, AM413FVT, 
AM413FVT2, AM413FIT models.   
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Chapter 5 - Capturing Video  

To capture video, go to the “Capture” tab on the main toolbar and select Video. 

 

A window will open up allowing you to set the frames rates, set a video recording time limit, and 
enable or disable the audio.  

 

Before you start capturing video, click on the Compress tab. The Video Compression window 
will give you a list of “Compressors” you can choose from. 

To get most out of the video recording performance, you may opt to download or buy the codec 
from the codec providers.    DivX (www.divx.com) is one of our recommandation. 

 

After you have selected a Video Compressor from the drop down menu, click OK. The Video 
Compression window will close. Then click Start on the Capture Video Parameters window to 
start capturing video. 
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5.2 Capturing Time Lapsed Video 

The Dino Capture Digital Microscope has the unique function of allowing you to set Time 
Lapsed Video. This function can be used for capturing events such as the sprouting of a seed, 
the hatching of an egg, or the blossoming of a flower.  

To capture a Time Lapsed Video, go to the “Capture” tab on the main toolbar on the main menu. 
Select the “Time Lapsed Video” option or click F7.  A new window will open allowing you to set 
the date and time you desire the Dino-Lite Digital Microscope to start capturing video.  

 

This window will open up allowing you to set the date, time, and total frames desired for the 
Time Lapsed Video Capture.  

 

Each frame represents a snapshot taken of the object being observed.  The “intevals” are how 
much  time elapses between each snapshot.  

The “Insert” tab allows you to insert additional frames to the ones already programed between 
intervals.
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Chapter 6 - Measurement Functions  

6.1 Steps for Using Measurement Functions  

Step 1: Bring image into focus by adjusting the dial on the side of the unit.  Once in focus at 
the desired magnification, take a picture by clicking “Capture.”  The captured image will then be 
displayed in the picture scroll list located under the picture tab. 

 

Step 2: To determine the magnification value of the image, refer to the reading on the center of 
the focus dial indicated by a small node.  This is the magnification value for the captured image.  
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To enter this value, place your mouse over the captured image in the left-hand column, select 
“Set Magnification” and enter the magnification value. This set value will now be displayed in the 
upper right hand corner of the image, and will be used as a standard for measurement purposes. 

 

Step 3: To utilize the measurement features simply double click on the desired image in the left 
hand column, and refer to the feature icons in the top row.  Click on the “Measure” icon and 
choose from one of the selections below. 

 



DinoCapture User’s Manual 

6.2 Angle Measurement 

This function allows measurement of an angle.  Simply click and drag to extend out to the 
desired angle. 

 

6.3 Line Measurement 

The Line measurement allows you to measure from one point to the next.  Simply click and 
drag to the desired length, and then click again to lock-in. 
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6.4 Continuous Line Measurement  

The Continuous line function allows measurements of multiple connecting lines.  Click and 
drag to connect desired points, and then click again to lock-in.  Continue until all points have 
been connected. 

 

6.5 Radius Circle Measurement  

Radius Circle allows you to measure the radius, circumference and area of a circle.  Simply 
click and extend out to the desired radius. 

. 
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6.6 Diameter Circle Measurement  

This function allows measurement of the diameter, circumference and area of a circle.  Simply 
click and extend out to the desired diameter. 

 

6.7 Three Point Circle Measurement  

The Three Point Circle allows measurement of the radius, circumference and area of a circle by 
simply defining any three points and clicking. 
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Chapter 7 - DinoCapture Calibration 

7.1 How to Use the Calibration Fun 

Step 1: Select a known measurement standard, such as a ruler, to be used for calibration.  
Take a picture of the selected measurement standard. 

 

Step 2: Now open the picture of the measurement calibration standard. 

 

Step 3: Determine the magnification value from the reading on the DinoLite adjustment dial.  
Enter this  value in the “Input Mag” box located in the upper right hand corner of the screen. 
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Step 4: Now click on the measurement icon at the top of the page and select “Calibration.” 

 

Step 5: The software will then prompt you to take a measurement on the selected calibration 
standard.  

  

Step 6: Take a sample measurement of the selected calibration standard by clicking on 
beginning and ending points across a known measurement value (such as 5 mm, .5 in., etc.).  
A measurement value before calibration will be displayed (5.179 mm in the example below).  
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Step 7: Enter the exact known value of the measurement sample (5.0 mm in this example) in 
the “Adjusted Mag” window.  Click “OK.” 

 

Step 8: The software will automatically calibrate the magnification rate and will show the 
adjusted magnification rate in the upper right corner of the picture. 

 

Step 9: Now the software is ready to take calibrated measurements with adjusted magnification 
rates.  To verify calibration simply take another measurement sample of a known measurement 
value.  

 

Notes:  

1. Calibration can be done at both lower magnification rates (<80x) and higher magnification 
rates  (>80x) respectively.  However, it will be more accurate if the calibration is done at the 
magnification rate closest to the one used for measurement.  

2. The calibration can be cleared by selecting “Clear All Calibration.”  
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3. The measurement can also be ignored without clearing the calibration by disabling the 
“Measure with Adjusted Mag. Rate.”  The Adjusted Mag. will not be shown in the picture if the 
calibration is disabled.  

4. The following Dino-Lite Digitlal Microscope models contain the Measurment & Calibration 
Functions:   

AM413T Series, among which, but not limited to, are the AM413ZT, AM413FVT, 
AM413FVT2, AM413FIT models 
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Chapter 8 - Help Options  

8.1 DinoCapture Update 

The DinoCapture Update option will allow you to check for new software updates which may be 
available for download. To check if there are any new updates for your Dino-Lite Digital 
Microscope,  go to the “Help” tab and click on “DinoCapture Update.” If there is an available 
update available for  download a window will open informing you of the new version currently 
available and will ask you if  you would like to download it. To download click on “Yes.”  

 

8.2 About DinoCapture 

When selected, the “About DinoCapture” tab on help will tell you what DinoCapture Digital 
Microscope  version you are currently running. 

 


